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Chapter 2 
ResSim Concepts 

 

Before you begin working with the individual modules available in 
ResSim, you will need to understand the concepts that will allow you to 
develop, access and interact with watersheds in ResSim.   

This chapter begins with the following basics:  explaining how to start 
ResSim; describing screen components that are common across modules, 
including menu items and map/mouse tools; and showing you how to 
create a new watershed or open an existing watershed. 

Next, you will learn about the following four kinds of schematic elements 
in ResSim:  Time-Series Icons, the Stream Alignment, Watershed (Study) 
Components, and the Model Schematic.  This chapter also explains how to 
interact with schematic elements using right-click shortcut menus, which 
allow you to plot and tabulate data, edit model data, and edit common 
components of the watershed. 

Layers are another concept in ResSim.  This chapter will help you to 
understand how layers work in ResSim and describe the six kinds of 
layers:  Time Series, Study, Stream Alignment, Gridded Data, Model 
Schematic, and Maps. 

To work with Layers, you will use the Layer Selector.  This chapter 
describes the components of the Layer Selector, including its menu items 
and layout, and shows you how to control layer display using the Layer 
Selector.  You will learn how to view layer legends, organize layers, 
configure toolbar icons to control layer display, and add and remove map 
layers. 

Each layer has a unique set of properties that you can configure to make 
your watershed display look the way you prefer.  This chapter shows you 
how to use Properties Editors and other tools to configure the properties of 
Time Series, Study, Stream Alignment, Gridded Data, Model Schematic, 
and Map layers. 
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2.1 Starting ResSim 
To begin working with the Watershed Data Sets, you must first start 
ResSim.  Either double-click the HEC-ResSim icon on your PC’s desktop, 
or from the Start menu, select Programs → HEC → ResSim.  Once you 
start ResSim, an information screen (as shown in Figure 2.1) will appear 
briefly; then, ResSim’s Main Window will open (Figure 2.2). 

Title Bar Display Area 

Menu Bar 

Module List 

Toolbar 

Status Bar 

General Message Bar 

Figure 2.2  ResSim Main Window 

Figure 2.1  ResSim Information Screen 
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2.2 Recognizing Common Screen Components 
ResSim offers three modules, each with its own functions and module-
specific tools, menus, and output.  However, the modules share common 
screen components, as previously illustrated in Figure 2.2. 

The Title Bar displays the ResSim title.  After a watershed is opened, the 
name of the watershed will appear. 

The Menu Bar contains menus for the modules.  The items on the menus 
change as you switch between the modules, offering module-specific 
commands.  You can select a menu item by clicking on the name of the 
menu (such as File), then pointing and clicking on the item you wish to 
select.  Section 2.2.1 describes the Menu Bar in more detail. 

The Module List contains all the available modules of ResSim.  Use this 
list to move between the Watershed Setup module, the Reservoir Network 
module, and the Simulation module.  Section 2.2.2 describes the Module 
List in more detail. 

The Display Area is the geographic-referenced (geo-referenced) map 
space where all model schematic objects (reservoirs, junctions, diversions, 
etc.), watershed objects (stream alignments, reservoirs, stream reaches, 
etc.), and map layers are shown.  You can manipulate elements and view 
results in the modules through the use of the tools in the Toolbar.  Tools 
that affect the Display Area can have different functions depending on 
which module is selected. 

The Status Bar displays map coordinates of the pointer in the display area 
when you are interacting with the watershed.  When the pointer is outside 
of the display area, the Status Bar reflects the status of the program. 

The General Message Bar displays a scrolling list of messages.  System 
output log information appears in this window from the time you start 
ResSim until you exit the program.  The scroll buttons on the right end of 
the Message Bar control the display and allow you to review all messages 
received during your ResSim session. 

2.2.1 Menu Bar 
In the Menu Bar, the File, View, Tools, and Help menus contain 
commands you can access from all three ResSim modules.  Some of 
these menus also contain module-specific commands that appear only 
within individual modules.  Commands and options that are common 
to all three modules are described as follows: 
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The File menu (Figure 2.3) allows you to 
create a New Watershed, Open an 
existing watershed, Save a watershed, 
Save Map (the Display Area) and Exit 
ResSim. Your most-recently-used 
watersheds are located at the bottom of 
the File menu.  When a watershed is 
opened, the remaining menu items 
become active. 

 

In the View menu (Figure 2.4), select Zoom to 
All to restore your watershed view to full size 
after zooming in on one portion.  Layers opens 
the Layers Selector dialog box which is used to 
select the spatially referenced layers 
(map/coverage).  Unit System allows you to 
see the current screen view settings.  You can 
view data using whichever Unit System you 
prefer (English or SI); however, the Watershed 
(native) Unit System is established when a 
watershed is created and cannot be changed afterward (see Tools 
menu for Watershed information).  Lastly, if a dialog or editor 
window is open but inactive, Restore Windows brings the dialog or 
editor window to the front as the active window. 

 

The Tools menu (Figure 2.5) provides access to 
Hec-DssVue, which you will use to view (and 
possibly edit) dssfiles that are used for storing 
primarily time-series data.  The Scripts command 
allows you to create, open and edit scripts (the 
scheduling of scripts is accomplished in the 
Simulation Module, from the Edit Menu).  
Options lets you specify watershed locations for 
storing your watersheds; specify a directory for 
caching map files; set the colors for compute 
messages and the format of log files; set the level of debug messages; 
choose whether or not you want a confirmation message to appear 
when you exit ResSim; and choose whether you want the last 
watershed reloaded at startup of the program.  Information provides 
details about client, user, and watershed settings as well as server and 
system properties. 

Figure 2.3  File Menu 

Figure 2.5 
Tools Menu 

Figure 2.4  
View Menu 
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In the Help menu (Figure 2.6), the About  
command displays information about the 
version of ResSim. 

 

 

 

In addition to the four common menus described above, the following 
two menus appear in all three modules but contain module specific 
commands: 

Edit – Typically, the edit options will be relevant to data 
element(s) for a specific module.  The edit options available for 
each module are described in more detail in subsequent sections of 
this chapter. 

Reports – Provides access to reports produced for a specific 
module.  The reports available for each module are described in 
more detail in subsequent sections of this chapter. 

2.2.2 Module List 
From the ResSim main window (Figure 2.2) the graphical user 
interface (GUI) is organized to provide the necessary information to 
enter data, review data, edit data, run a simulation, and view results.  
The steps are divided into separate sets of functions called modules.  
A module has a specific set of commands that are accessed through 
menus and toolbars.  Each module provides access to specific types of 
data or results.  The modules of ResSim are as follows: 

 
Watershed Setup – create a stream alignment, define projects 
(e.g., reservoirs, levees), define computation points, identify 
impact areas, create configurations for the watershed, and define 
time-series icons that represent specific locations or time-series 
identifiers.  Section 2.3 provides more details of this module. 
 
Reservoir Network – create networks, add routing reaches, edit 
elements, create and edit alternatives including assigning the DSS 
pathnames for time-series references.  Section 2.4 provides more 
details of this module. 
 
Simulation – define simulations for a watershed.  A simulation 
consists of a time window and the ResSim alternatives you wish to 
execute for the simulation.  Within this module, you can also edit 
element data.  Once a simulation is defined, a compute is 
performed and the results are analyzed using graphical and tabular 
output.  Section 2.5 provides more details of this module. 

Figure 2.6  Help Menu
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Each module has a menu bar and toolbar that are very similar for all 
of the modules.  Example windows for each of the modules are 
presented in subsequent sections of this chapter. 

2.3 Watershed Setup Module 
The Watershed Setup module is used to create and setup your watershed.  
From the Module list, select Watershed Setup.  The main window and 
the different components for the Watershed Setup module are illustrated 
in Figure 2.7. 

 

The Menu Bar (in Figure 2.7) contains the menus for the Watershed 
Setup module.  In addition to the four common menus described in 
Section 2.2.1, the following list is a description of the available menus in 
the Watershed Setup module. 

Edit – From this menu, you can edit study information and view 
watershed information, edit global information for impact areas 
and projects, and adjust the colors and fonts used by the individual 
projects.  Also, you can set the lock for editing the stream 

Title Bar 

Menu Bar 

Module List 

Zoom Tool 

Stream 
Alignment 
Tool 

Display Area Setup Lock 

Configuration
List

Project 
Tools 

Pointer/Selector Tool 

Pan Tool 

Time-Series Icon Tool

Stream Node Tool

Impact Area Tool

Common Computation Point Tool

Status Bar 

General Message Bar 

Figure 2.7  Watershed Setup Module 
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alignment and/or configurations.  Available commands are:  
Watershed Data, All Impact Areas, Projects, Drawing 
Properties, and Allow Editing. 

WaterShed – From this menu, you will establish the program 
sequence, create and edit configurations.  You can also import 
and/or export the Stream Alignment.  Available commands are:  
Program Sequence, Configuration Editor, Update 
Computation Points, Import, Export, and Save Configuration. 

Reports – From this menu, you can review reports.  These reports 
contain information about the streams, watershed elements, and 
configurations for the watershed.  The available reports are:  List 
of Streams, List of Impact Areas, List of All Configurations, 
List of Computation Points, and Projects. 

 

The Configuration List (in Figure 2.7) shows the current configuration.  
Configurations are created, edited, and deleted in the Watershed Setup 
module.  See Chapter 7 for discussion on Watershed Configurations. 

 

The Setup Lock       (in Figure 2.7) allows you to edit the stream 
alignment and the current configuration.  This lock prevents others from 
editing the stream alignment and configuration elements while you are 
editing. 

 

The Display Area (in Figure 2.7) is where you create and view the stream 
alignment, projects, impact areas, and computation points through the use 
of the available tools in the Watershed Setup module.  The following are 
descriptions of the available tools: 

 

Pointer/Selector Tool –this tool can be used to edit, rename, and 
delete elements.  To access, select the Pointer/Selector Tool, click 
the right mouse button (right-click) on an element, and the 
commands are available from a shortcut menu. 

Zoom Tool - this tool allows zooming in and out of the display 
area.  To zoom in, hold the left mouse button down and outline the 
area you want to zoom in on.  To zoom out, right-click in the 
display area. 

Pan Tool – this tool can be used to move the display area while 
you are zoomed in.  To do this, hold down the left mouse button 
and drag the mouse in the direction you would like to pull the 
display area. 
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Time-Series Icon Tool - this tool is used to create, delete, and 
rename time-series icons used for plotting and tabulating time-
series data.  To create, select the Time-Series Icon Tool, hold 
down the CTRL key and click.  To access the available 
commands, select the Time-Series Icon Tool, right-click on a 
time-series icon, and the commands are available from the shortcut 
menu. 

Stream Alignment Tool - this tool is used to create, delete, and 
edit stream elements that make up the stream alignment. 

Stream Node Tool - this tool is used to create, delete, and edit 
stream nodes on the stream alignment. 

Impact Area Tool - this tool is used to create, delete, rename, and 
edit impact areas.  To create, select the Impact Area Tool; hold 
down the CTRL key while clicking the mouse button.  Each click 
creates a vertex point, which is the boundary of the polygon.  
When reaching the end point, release the CTRL key and double-
click.  An impact area element is now visible.  To access the 
available commands, select the Impact Area Tool, right-click on 
the impact area, and the commands are available from the shortcut 
menu. 

Computation Point Tool - this tool is used to create, edit, rename, 
and delete computation points.  Computation points are locations 
where time-series information is to be exchanged between models.  
For ResSim, this might be a control location for reservoir 
operations, a location where flows will be input, a location where a 
hydrograph is needed for FIA, etc.  To create a computation point, 
select the Computation Point Tool, hold down the CTRL key 
and click on the stream alignment at the appropriate location.  To 
access the available commands, select the Computation Point 
Tool, right-click on the computation point, and the commands are 
available from the shortcut menu. 

 

Project Tools: 

Reservoir Tool - this tool is used to create, delete, rename, and 
edit reservoirs.  To create a reservoir, select the Reservoir Tool.  
A reservoir has to be created on the stream alignment.  Hold down 
the CTRL key and click on the upstream end of the reservoir pool, 
release the CTRL key, drag along the stream alignment to the 
downstream end of the reservoir pool and click, and then name the 
reservoir.  To access available commands, select the Reservoir 
Tool, right-click on the reservoir, and the commands are available 
from the shortcut menu. 
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Levee Tool - this tool is used to create, delete, rename, and edit 
levees.  To create a levee, select the Levee Tool.  A levee has to be 
created on the stream alignment.  Hold down the CTRL key and 
click on the upstream end of the levee, release the CTRL key, drag 
along the stream alignment to the downstream end of the levee and 
click.  To access available commands, select the Levee Tool, right-
click on the levee, and the commands are available from the 
shortcut menu. 

Diversion Tool - this tool is used to create, delete, rename, and 
edit diversions.  To create a diversion, select the Diversion Tool.  
A diversion has to begin on the stream alignment.  Hold down the 
CTRL key and click on the stream alignment.  Each click creates a 
vertex point, along the diversion.  When reaching the end point of 
the diversion release the CTRL key, and click.  To access 
available commands, select the Diversion Tool, right-click on the 
diversion, and the commands are available from the shortcut menu. 

Channel Modification Tool - this tool is used to create, delete, 
rename, and edit channel modifications.  To create a channel 
modification, select the Channel Modification Tool.  A channel 
modification has to be created on the stream alignment.  Hold 
down the CTRL key and click on the upstream end of the channel 
modification, release the CTRL key, drag along the stream 
alignment to the downstream end of the channel modification and 
click.  To access available commands, select the Channel 
Modification Tool, right-click on the channel modification, and 
the commands are available from the shortcut menu. 

Off-Channel Storage Area Tool - this tool is used to create, 
delete, rename, and edit off-channel storage areas.  To create an 
off-channel storage area, select the Off-Channel Storage Area 
Tool and hold down the CTRL key while clicking the mouse 
button.  Each click creates a vertex point, which is the boundary of 
the polygon.  When reaching the end point, release the CTRL key 
and double-click.  An off-channel storage area element is now 
visible.  To access available commands, select the Off-Channel 
Storage Area Tool, right-click on the off-channel storage area, 
and the commands are available from the shortcut menu. 

Other Project Tool - this tool is used to create, delete, rename, 
and edit other projects.  This tool enables the placement of 
elements that represent "other" projects, such as pump stations and 
gages.  To create an “other” project, select the Other Project Tool 
and hold down the CTRL key and click.  To access available 
commands, select the Other Project Tool, right-click on the other 
project, and the commands are available from the shortcut menu. 
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2.4 Reservoir Network Module 
The Reservoir Network module is used for editing element data and 
placing additional elements onto the stream alignment.  From the Module 
list, select Reservoir Network.  The main window and the different 
components for the Reservoir Network module are illustrated in 
Figure 2.8. 

 Your network elements will not be shown in the Display Area 
until you create or open a network from the Network Menu. 

 

The Menu Bar (in Figure 2.8) contains the menus for the Reservoir 
Network module.  After a reservoir network has been created or opened 
and is shown in the Display Area, the menus and their commands will 
become active.  In addition to the four common menus described in 
Section 2.2.1, the following list is a description of the available menus in 
the Reservoir Network module. 

Figure 2.8  Reservoir Network Module 
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Edit – From this menu, you can edit Reservoirs, Routing Reaches, 
Junctions, Diversions, and Reservoir Systems.  Also, you can set 
the lock for editing the reservoir network.  Available commands 
are:  Reservoirs, Reaches, Junctions, Diversions, Reservoir 
Systems, and Allow Network Editing. 

Network – From this menu, you will create, open, save, rename 
and delete reservoir networks.  You can also update a network to 
recognize revisions made to its configuration within the Watershed 
Setup module.  Available commands are:  New, Open, Save, Save 
As, Rename, Update Network from Configuration, and Delete 
Networks. 

Alternative – From this menu, you will open the Alternative 
Editor that will enable you to create, edit, save and delete 
alternatives.  The only command available from this menu is Edit. 

Reports – From this menu, you can review reports that list the 
elements for the currently opened network.  These reports contain 
information about the reservoirs, routing reaches, junctions and 
diversions.  Also, an advanced network summary listing is 
available.  The available reports are:  Reservoir List, Reach List, 
Junction List, Diversion List, and Advanced. 

The Network box (in Figure 2.8) shows the “currently opened” Reservoir 
Network.  You will not see a watershed schematic in the Display Area 
until you create or open a network. 

The Configuration box (in Figure 2.8) shows the configuration the 
currently opened Reservoir Network is based upon.  If you make changes 
to the network’s Configuration (within the Watershed Setup module), then 
you can update the network(s) that use that configuration to recognize 
those revisions by selecting the Update Network from Configuration 
command from the Network menu. 

The Network Lock        (in Figure 2.8) allows you to edit the elements 
within the Reservoir Network.  This lock prevents others from editing the 
elements while you are editing. 

The Display Area (in Figure 2.8) is where you create the routing reaches 
for your Reservoir Network.  Also, you can edit the elements through the 
use of the available tools in the Reservoir Network module.  The 
following are descriptions of the available tools: 

Pointer/Selector Tool –this tool can be used to edit, rename, and 
delete elements.  To access, select the Pointer/Selector Tool, 
right-click on an element, and the commands are available from a 
shortcut menu. 

Zoom Tool - this tool allows zooming in and out of the display 
area.  To zoom in, hold the left mouse button down and outline the 
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area you want to zoom in on.  To zoom out, right-click in the 
display area. 

Pan Tool –this tool can be used to move the display area while 
you are zoomed in.  To do this, hold down the left mouse button 
and drag the mouse in the direction you would like to pull the 
display area. 

Reservoir Tool - this tool is used to create, edit, and delete 
reservoirs.  Typically, you will only be “editing” reservoirs within 
the Reservoir Network module.  The other options would normally 
be done within the Watershed Setup module.  To access available 
commands, select the Reservoir Tool, right-click on the reservoir, 
and the commands are available from the shortcut menu. 

Diverted Outlet Tool - this tool is used to create, edit, rename, 
and delete diverted outlets from a reservoir.  To create a diverted 
outlet, select the Diverted Outlet Tool.  A diverted outlet must 
originate from a reservoir.  Hold down the CTRL key and click on 
the appropriate reservoir, release the CTRL key, move the mouse 
pointer to a location in the watershed that will receive the diversion 
from the outlet and click.  It is possible to create a diverted outlet 
that re-enters the network system.  To do this, continue holding 
down the CTRL key and click to create vertex points and release 
the key when you are ready to place the final point back into the 
system.  To access available commands, select the Diverted 
Outlet Tool, right-click on the diverted outlet, and the commands 
are available from the shortcut menu. 

Routing Reach Tool - this tool is used to create, edit, rename, and 
delete routing reaches.  A routing reach must be created between 
junctions and will follow the stream alignment.  Attempting to 
create a reach where junctions don’t exist will automatically 
generate junctions at the upstream and downstream ends of the 
reach.  To create a routing reach, select the Reach Tool, hold 
down the CTRL key and click on the junction at the upstream end 
of the reach, release the CTRL key, drag along the stream 
alignment to the junction at the downstream end of the reach and 
click.  To access available commands, select the Reach Tool, 
right-click on the routing reach, and the commands are available 
from the shortcut menu. 

Junction Tool - this tool is used to create, edit and delete 
junctions.  To add junctions (before creating routing reaches), 
select the Junction Tool, hold down the CTRL key and click on 
the stream alignment where you want to create the junction.  To 
access available commands, select the Junction Tool, right-click 
on the junction, and the commands are available from the shortcut 
menu. 
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Diversion Tool - this tool is used to create, edit, rename, and 
delete diversions.  To create a diversion, select the Diversion Tool.  
A diversion must begin from a junction.  Hold down the CTRL 
key and click on the junction from which the diversion will occur.  
If you continue to hold down the CTRL key, each click creates a 
vertex point along the diversion.  When reaching the end point of 
the diversion release the CTRL key, and click.  Diversions can re-
enter the network or leave the network system entirely.  To access 
available commands, select the Diversion Tool, right-click on the 
diversion, and the commands are available from the shortcut menu. 

2.5 Simulation Module 
The Simulation module is used to perform a simulation (compute), edit 
element data and view results.  From the Module list, select Simulation.  
The main window and the different components for the Simulation 
module are illustrated in Figure 2.9. 
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Figure 2.9  Simulation Module 

Control Panel 
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The Menu Bar (in Figure 2.9) contains the menus for the Simulation 
Module.  After a simulation has been created or opened and is shown in 
the Display Area, the menus and their commands will become active.  In 
addition to the four common menus described in Section 2.2.1, the 
following list describes the available menus in the Simulation Module. 

Edit – From this menu, you can edit the list of scheduled Scripts,  
make an Alternative Active, and edit Reservoirs, Routing Reaches, 
Junctions, Diversions, and Reservoir Systems.  Available 
commands are:  Script List, Set Active Alternative, Reservoirs, 
Reaches, Junctions, Diversions, and Reservoir Systems. 

Simulation – From this menu, you can create, open, re-open, 
close, edit, save, and delete simulations.  You can also get 
information about the currently opened simulation and define 
release and target elevation overrides.  Available commands are:  
New, Open, Re-Open, Close, Edit, Save, Delete, Info, and 
Release Overrides. 

Alternative – From this menu, you can edit alternatives.  This 
menu only becomes active when a simulation is open.  The only 
available command is Edit. 

Reports – The available reports summarize results and provide 
network input summaries for the currently opened simulation.  
Available commands are:  Reservoir Summary, Flow Summary, 
Power Summary, Gates Summary, Stage Summary, Release 
Decision, Compute, and Network. 

 

The Display Area (Figure 2.9) is where your stream alignment and 
watershed elements are displayed.  You can view simulation results and 
edit projects and computation points through the use of the available tools 
in the Simulation Module.  The following are descriptions of the 
available tools: 

Pointer/Selector Tool –this tool can be used to edit projects and 
computation points, plot hydrographs, and view results.  To access 
this tool, select the Pointer/Selector Tool, right-click on a location 
and select commands from the shortcut menu. 

Zoom Tool - this tool allows zooming in and out of the display 
area.  To zoom in, hold the left mouse button down and outline the 
area to which you want to zoom.  To zoom out, right-click in the 
display area. 

Pan Tool – this tool can be used to move the display area while 
you are zoomed in.  To do this, hold down the left mouse button 
and drag the mouse in the direction you would like to pull the 
display area. 
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The Control Panel (Figure 2.9) shows the time window for the currently 
selected simulation in the Simulation Module.  Also from the Control 
Panel you can manipulate simulations and alternatives. 

 

2.6 Opening an Existing Watershed 
With the ResSim main window open, you will need to open a watershed.  
In ResSim, a watershed is a data set associated with a geographic region 
for which you may configure multiple models and area coverages.  A 
watershed may include all of the streams, projects (reservoir, levees), 
gage locations, impact areas, time-series locations, and hydrologic and 
hydraulic data for a specific area.  All of these details together, once 
configured, form a watershed data set. 

You may open an existing watershed from any of the modules (if you need 
to create a new watershed, refer to Chapter 3).  Three methods of opening 
an existing watershed are available: 

First, you can specify that your previously opened watershed be 
automatically opened by selecting Reload last Watershed at Startup 
from the General tab of the Options dialog box (Figure 2.10) from the 
Tools menu. 

 
Figure 2.10  Tools Menu, Options Dialog Box, General Tab:  
Reload last Watershed at Startup 

Second, if you have opened the watershed before, you can select it from 
the list of most-recently-used watersheds, located at the bottom of the File 
menu. 

Third, you may use the Open Watershed dialog to open the watershed, as 
follows: 
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1. On the File menu, 
click Open 
Watershed.  The 
Open Watershed 
dialog box (Figure 
2.11) will open. 

2. Select a watershed 
from Available 
Watersheds (see 
Chapter 3, Section 
3.3.1 for information 
on defining 
Watershed Locations).  The Current Watershed box displays 
the watershed that is currently open, if any. 

3. Click OK.  The Open Watershed dialog box will close and the 
watershed you have selected will load and appear in the main 
window with the watershed name shown in the title bar. 

 
 You can have only one watershed open at a time.  Therefore, if a 

watershed is open and you attempt to open another, the 
program prompts you to save the current watershed.  If you do 
not save, any changes you have made to the current watershed 
will be lost. 

 

2.7 Understanding Schematic Elements 
Schematic elements in ResSim allow you to represent watershed, reservoir 
network, and simulation data visually in a geo-referenced context that 
interacts with associated data.  You create schematic elements and edit 
their properties in the Watershed Setup Module (see Chapters 3 through 7) 
and the Reservoir Network Module (see Chapters 8 through 13).  In the 
Simulation Module (see Chapter 14), you can plot and tabulate data by 
using the shortcut menus associated with the schematic elements. 

 
Figure 2.11  Open Watershed Dialog 
Box 



ResSim User’s Manual  Chapter 2 – ResSim Concepts
 

2-17 

2.7.1 Stream Alignment 
The Stream Alignment (Figure 
2.12) is a common component of 
the watershed.  To create it, use 
the map (mouse) tools in the 
Watershed Setup Module to draw 
multi-segmented lines into the 
map display and to mark nodes 
and stream junctions. 

Stream elements (segments), 
stream nodes, and stream 
junctions are the components of a 
Stream Alignment.  See Chapter 5 for more detailed information on 
creating and editing a Stream Alignment. 

2.7.2 Other Watershed Elements 
Other watershed elements include Projects, Computation Points, 
Impact Areas and Time-Series Icons.  Create watershed elements in 
the Watershed Setup Module (see Chapter 6). 

These watershed elements are common components of a watershed 
that multiple models can reference (e.g., ResSim and FIA).  To 
represent the elements, you use the Watershed Setup Module’s map 
(mouse) tools to insert icons and draw polygons and multi-segmented 
lines into the map display. 

Projects include Reservoirs (Figure 2.13), Levees (Figure 2.14), 
Diversions (Figure 2.15), Channel Modifications (Figure 2.16), Off-
Channel Storage (Figure 2.17), and Other Projects like pump stations 
and agricultural diversions (Figure 2.18). 

 
Figure 2.13  Reservoir  

 
Figure 2.14  Levee 

 
Figure 2.15  Diversion 

 
Figure 2.16  Channel 
Modification  

 
Figure 2.17  Off- 
Channel Storage  

 
Figure 2.18  Other 
Project 

Figure 2.12  Stream Alignment 
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Computation 
Points (Figure 2.19) 
are common points 
where data is 
exchanged between 
models.  To 
represent them, you 
use the map 
(mouse) tools to 
insert icons into the 
map display. 

Impact Areas 
(Figure 2.20) are 
common elements 
representing distinct 
portions of a 
watershed affected 
by rising stage in a 
stream, river, lake, 
or reservoir where 
flood damages will 
be evaluated. 

For more information about Impact Areas, refer to the HEC-FIA 
User’s Manual (HEC, 2003c). 

Time-Series Icons (Figure 2.21) indicate 
sites where time-series data is available. You 
can use Time-Series Icons to represent the 
locations of gages or Time-Series locations. 

For more information about Time-Series 
Icons, refer to the CWMS User’s Manual 
(HEC, 2003a). 

 

 

 

2.7.3 Reservoir Network Schematic 
The Reservoir Network Schematic, which you develop in the 
Reservoir Network Module (based on a Configuration created in the 
Watershed Setup module), is a template for simulation computations.  
The graphical elements allow you to access data editors and specify 
properties of reservoir network components. 

Figure 2.19  Computation Points 
 

Figure 2.20  Impact Areas 

 
Figure  2.21 
Time-Series Icons  
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The Reservoir 
Network Schematic 
(Figure 2.22) displays 
geo-referenced, 
graphical 
representations of 
Reaches, Diversions, 
Junctions, and 
Reservoirs.  When you 
interact with these 
representations in the 
Simulation Module, 
you are able to view 
results from the ResSim 
model’s observed and 
computed hydrographs.  

The Schematic is visible in the Reservoir Network module only 
when a Network has been opened and is visible in the Simulation 
module only when a Simulation Alternative is “set as active”. 

2.7.4 Using Shortcut Menus 
Shortcut menus display when you right-click on schematic elements 
in the map display and other ResSim components such as plots, 
tables, and “tree structures”.  In ResSim, shortcut menus offer a 
variety of commands and options that allow you to access data 
editors, plot and tabulate data, view reports, compute Simulations, and 
more.  Specific shortcut menu commands and options are described 
throughout this manual. 

2.8 Printing and Exporting Reports 
From each individual report there is a shortcut menu that allows you to 
print the report, preview the report before you print, and export the report 
to an ASCII delimited file.  Right-clicking on the active report accesses 
the shortcut menu.  Another way to print or export the reports is by 
clicking on Export or Print from the report’s Report menu (in the 
Reservoir Network or Simulation module) or from the report’s File menu 
(in the Watershed Setup module).  Either method accesses the same dialog 
boxes. 

2.8.1 Printing Reports 
The output will be a print of the screen image of the active report.  If 
items in the columns of the report are not printing, you can use the 
mouse to resize the column widths and the width of the entire report 
dialog box if you need to see more detail.  To do so, roll the mouse 

 
Figure 2.22  Reservoir Network Schematic 
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pointer over one of the lines that delimit the columns or over the 
dialog box border.  You can click on that line with the left mouse 
button and drag the mouse from side to side to indicate how wide you 
want the columns or dialog box.  If you end up highlighting some 
cells in the table, then you probably moved the mouse slightly just 
before you pressed the button. 

To print a report from the Watershed Setup module: 

1. You must have a report 
selected (opened).  For 
example, from the Reports 
menu in the Watershed 
Setup module, select List 
of Computation Points 
(Figure 2.23). 

 
 
 

2. From the File menu of the 
opened report, select Print 
(Figure 2.24).  Or, you can 
right-click anywhere within 
the tabulated data of the 
report and from the shortcut 
menu select Print (Figure 
2.25). 

 
 

 
Figure 2.25  Select Print from Report’s Shortcut Menu 

 

Figure 2.23  Selecting a Report 

Figure 2.24  Select Print from 
Report’s File Menu 
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3. The Print Properties dialog box will open (Figure 2.26). 

Figure 2.26  Printing Properties, 
Page Tab 

4. From the Page tab (Figure 2.26), you can set the orientation 
(default is Portrait), make the report columns fit on one page, 
print the entire table (default) or print selected cells, repeat 
headers on subsequent pages, and display gridlines.  By default 
the report prints in an ASCII format, if you want a screen 
image of the report, unclick ASCII and the report will print 
with any shading that you see on the report. 

5. The Header/Footer tab (Figure 2.27) allows you enter a 
header and/or footer for the report. 

6.  The Table Title tab (Figure 2.28) allows you to change the 
default title of the report, and to determine whether you want 
the report title repeated on subsequent pages. 

 

 
Figure 2.28  Printing 
Properties, 
Table Title Tab 

 
Figure 2.27  Printing 
Properties, 
Header/Footer Tab 
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7. After you have everything set, click Print and the default 
system Print dialog box will open (Figure 2.29).  Select the 
printer, and any other options you wish to set, click OK.  The 
report will then be printed on the selected printer. 

 
Figure 2.29  System Print Dialog Box 

2.8.2 Print Preview 
You can also preview the report before printing.  To do so, do the 
following: 

1. You must have a report selected (opened). 
2. Right-click anywhere within the tabulated data of the report 

and from the shortcut menu, select Print Preview (Figure 
2.30). 

Figure 2.30  Select Print Preview from Report’s Shortcut Menu
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3. The Properties dialog box (see Figure 2.26) will appear. 
4. Make the same adjustments for printing as described in Section 

2.8.1.  When you are satisfied, select Print from the 
Properties dialog box, and the Print Preview dialog box 
(Figure 2.31) will open. 

 
Figure 2.31  Print Preview Dialog Box 

5. If you like what you see in the Print Preview dialog box, you 
can print by clicking Print, which opens the system Print 
dialog box (see Figure 2.29), or you can close the Print 
Preview dialog box by clicking Close. 

2.8.3 Exporting Reports to a File 
You can also export reports to an ASCII delimited file.  To export a 
report from the Watershed Setup module, do the following: 

1. You must have a 
report selected 
(opened). 

2. From the File menu of 
the opened report, 
select Export (Figure 
2.32).  Or, you can 
right-click anywhere 
within the tabulated 
data of the report and 
from the shortcut 
menu select Export 
(Figure 2.33). 

 
Figure 2.32  Select Export from the 
Report’s File Menu 
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Figure 2.33  Select Export from Report’s Shortcut Menu 

 
3. The Table Export 

Options dialog box 
(Figure 2.34) will 
open.   

4. You can select the 
Field Delimiter from 
the list to be TAB, 
SPACE, COMMA, or 
COLON. 

5. By default, the export 
does not use fixed 
width columns; 
however, if you want 
to do this you can click 
in the Fixed Width 
Columns checkbox. 

6. You can also include the Column Headers of the report 
(default), include Gridlines, and include the Title of the report. 

7. Once you have chosen your desired options, click OK and the 
System Save Browser (Figure 2.35) will open. 

 
Figure 2.34  Table Export Options 
Dialog Box 
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Figure 2.35  System Save Browser (for Saving a File) 

8. You will need to select where you want the file to be saved and 
a filename.  If you want the file to have an extension, you must 
enter your own; there is no default file extension. 

9. Click Save and the System Save Browser will close.  The 
filename that you entered will now be saved on your computer. 
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